VICTORIA POOL, BLOOMBERG:  Hi. My name is Victoria Pool and I'm here to walk you through Understanding Bloomberg's Launchpad, a customizable Window-esque interface that allows you to quickly, easily access the information you need most.

    In this session, we will cover the basics of the Launchpad application, how to build a monitor, news searches, add charts as well as some tips and tricks.

    What you are seeing now, is a Launchpad view created for an equity sales trader. By the end of this session, you will have all the tools available to replicate this view. 

    When you log into Bloomberg, the applications should be set up to launch automatically. But if it doesn't, you can always type into one of the panels B L P followed by the "enter" key to launch the application. 

    The Launchpad toolbar is the main frame or brains behind the application. What you also hear are the four taps. If you are unable to see these, they could be hiding underneath the "options" button in the upper right hand corner.

    You will see as I click this they toggle between being shown and hidden. The first tab we're going to go through is the "Views" tab. Underneath the Views tap, you will see that it's much like the file you can find on any other desk top application. One thing that should be highlighted is every change you make to your launchpad needs to be saved if you want to retain your custom made view. 

    Before I move on, I want to make sure you understand what I mean by "view". User groups of different functions arranged on a single page. 

    The next tab we have is the "Pages" tab. To create these pages on the view, we would like to look at the second tab. From this drop down you will see the options to create, delete, send and share a page. These will help you to order and maintain your pages within your view. 

    The next tab we have is the "Settings" tab. The Settings tab holds the default options of your launchpad. For example, how to choose which view to maximize upon startup. You can choose this option her on the top in the amber bar drop down. As well, you will see the options to choose which view you would like to display on your bio or profile as well as if you would like the launchpad to automatically load upon start up. Once you have elected these changes, you can click on the "Save" or the "Close"  button.

    The last tab you will see is the "Tools" tab. This allows you to create groups of functions, short cuts, to even a quick - and even a quick link to your monitor manager. We will be going over the group manager in depth later on. 

    As well, below these four options you will see an amber tool box as well as a browser option. First, we're going to go through the "Browser" option.

    The Browser is a quick link to search for components within the launchpad segregated by specific categories. When launched, you will see a list of categories on the left hand side and corresponding components on the right hand side. If you click into a component, you will see a preview of this component to the right. If you decide to launch said component, you can click on the "Launch Component" button on the bottom right. 

    There's also a "Search" field on the upper left hand corner that is extremely useful as well if you are unable to find a specific component. These components are also ranked by popularity on the right hand side indicated by the number of stars.

    Another way to search for components is through the amber box here. in this search field, you can search for a component, type in a function mnemonic or find the chart or monitor managers. For example, you can simply type in the type of function mnemonic you are looking for such as A N R and hit "Go". The launchpad is smart to recognize that you are trying to pull up the ANR page and it will automatically load. 

    As well, you can pull up, for example, the chart and Monitor Manager. For now, we are going to start with the Monitor Manager. After pulling up the Monitor Manager, you can see a list of monitors that I've created in the past. As well, there is a column to see when I last viewed the monitor. Additionally, you have the options to search for a monitor in the upper left hand corner as well as filter your monitors you've created and monitors you've received from other users.

    From the monitor, you can open a previously created monitor or create a new one. From here, we're going to go ahead and create a new one.

    When you create a new monitor, a black box with a grey outline will appear. There are five tabs just like on the toolbar that are now labeled "Monitor", "Views", "Alerts", "News", and "Link To". 

    Now, there are a couple ways to enter end-securities into your monitor. The first being to simply double click into the cell underneath the ticker column and type in the security. As you type in the security, you will see the auto complete drop down that will give you a list of related securities. 

    As well, a new feature we have on the launchpad is if you add an index. You will see that there is a "plus sign" next to the indices. If you right click, you will see the option to "Add Members" which is a quick link to add the members of the specified index. 

    The second way to input security tickers is a drag-and-drop, the push-pin from Excel. What I mean by this is, if you pull up a specified index within the mon - within the Bloomberg and go to the Members Page you will see in the upper right hand corner there is an Excel Push-Pin. You can click, drag and drop this into the monitor and you will see an option for how to import these securities. You can do this through "insert", "append", "replace all", or "replace from selected row". You can see that this has now replaced all the securities into the monitor from the Dow Jones Industrial.

    Another way to import the securities is by doing it by the "import securities" option. We have the option underneath the monitors "import security" tab. From here, you'll see the option to choose a source. For now, we're going to keep it simple and go to "Equity Index". We're going to specify the Dow Jones which is the "in do" and again, it's going to ask you how you'd like to import these securities.  So, for now, I'm going to replace them. Once I import, you can see that they are re-loaded into the same monitor. 

    So now that we have the securities in the monitor, we'd like to go through some of the options up here on these five tabs. Underneath the monitor tab, you will see another quick link to the "Monitor Manager", an option to re-name the monitor that you're currently using. "Import Securities" which we just went over, as well as the "Advanced Settings."  

    Underneath the "Advanced Settings" and where you see most of the customization options. Under here, you will see where you can make decisions such as Grid Lines and the News Minder.

    The News Minder allows you to change from the new style to the legacy style. The Legacy Style is where the tickers highlight by color indicating that there is news on that specified company. The new style is where there is a column indicating the news heat on those particular tickers. Once you elect your options, again, you can click on the "update" or the "closing" options. 

    You can see as well, as you click into these specified settings, on the right hand side you will see a definition of what this setting affects.

    The next tab is the "View" tab. The "View" tab, we're going to go over first, is the "Group Buy". The Group Buy option automatically groups your securities within your monitor by the specified classification. For example, if we group buy energy sector you will see that the Dow Jones is now grouped by the energy sector automatically. If I expand this, you will be able to see more. 

    If you would like to un-do this, you can simply go back to "view", "group buy" and un-check the option. 

    Next underneath the view is we have the "Summary Statistics". The Summary Statistics will add a row on to your monitor with the statistics for each individual data point. For example, if I add the average line and I update, you will see that you can now see the average price of the securities within the Down Jones Index - Industrials Index. 

    The next option that I would like to show you all is the "Panes". Panes is how you can separate a specific column or monitor into specified columns. So if I change it from Panes from single to two, you will see that there are now two columns of the tickers within the monitor. If I shrink this up, you will see how this will be a space saver for you later on.

    Again, if you would like to change that back, you can change it back form Panes to Single Pane.

    The next option underneath View that I'm going to show you all is the "Manage Columns". Manage Columns is where you can really customize the data on your monitor. You can see her on the right hand side there's a list of the columns you currently have within your monitor. On the left hand side is where you can search for columns that you'd like to add to your monitor.

    So, in this case, let's go ahead and we want to add the full name of the specified companies. So, I'm going to search by key word name and you will see here as I click on the field name a definition comes to the bottom. Once I decide this is the field that I would like to add, I can simply double click on the column and it's added to the right hand side. 

    As well, I can remove columns by simply highlighting the column and clicking on "remove". From this right hand side, we can also decide the order in which we would like the columns to be shown. So if I would like 'name' to be in a different location, I can simply click, drag and drop it into the location I would like.

    Once you have made all the changes you would like, you can click on the "update" option on the bottom right hand corner. 

    Another way to re-organize the columns is by clicking, dragging, and dropping the columns within the monitor just like in Excel. So if I would like to change the main column, I can simply click it, drag it and drop it to another location. There's even an option to - option to re-size the column widths by clicking, dragging or dropping the edge of the column header in or out. As well, you can automatically re-size it by simply double clicking. 

    The next tab we're going to go through is the "Alerts" tab. Under the Alerts is where you can create, edit and enable alerts. You will notice when I disable the alert column, the - that column will disappear and when I re-enable it, it will re-appear.

    Now, to create a simple alert, you can go to "alerts", "create new alert", and you will see the option to have this applied to all securities or an individual security. As we click "all securities" we can choose the specific field that we would like to it to apply to so we can change it to be current price is greater than and enter a specific value that we'd like. 

    Once we hit the "go" button the "create" key will open up and we can create this alert. Underneath the 'alert' column, you will notice that there are exclamation points in triangles. The exclamation point means that there is an alert set on this security. What the triangle means is that the alert has gone off on the security and this specific cell will be highlighted in the specified color. 

    The next tab is the "News" tab. The News tab has the same option to hide and display at the News (inaudible) column. This is specified for the news on the new style monitor. As well, we have the option to view news on all the securities with just a quick link to open up a panel within your Bloomberg for all the news on the securities on this monitor. The same goes for the research on all the securities as well. 

    The last option is the "Link to". This is where you can hit a quick link-to option to an intrerday market map. This will bring you straight to the iMap function linked to the launchpad monitor that you have just created.

    As well, there's a quick link to "option", to a real-time permissioning so you can see what securities in your monitor you do and do not have real-time permissioning for. The link-to components group, we will go over further during the tips and tricks section of this tutorial. 

    Another important feature to go over on this monitor is how to change the sizing. You will see in the bottom left, a "plus" and a "minus" sign. This is a quick link for how to zoom in and out on your monitor. These options are also available underneath the 'view' tab. For "view", "zoom" and you can choose the percentage you would like to zoom in and out. 

    Besides the 'zoom', we as well have the "grow height" column - the "row height" option where you can hit the plus and the minus sign to increase and decrease the row height size. 

    The last thing to highlight on this monitor is the option to "add function shortcuts". You can see these shortcuts by right-clicking on a specified security. These are quick links for you to pull up a certain function on the application to outside of launchpad. If you right click, do "edit", "function", "shortcuts", this is where you can enter in the function mnemonics. Once you accept these, you can right-click on and choose the function to quickly pull it up. This will help you with your security analysis.

    But what if I want to see scrolling news on all of the securities within this monitor? This is the perfect segue into how to create a news panel in the launchpad. To access news within the launchpad, we will again return back to the main toolbar and type in "news panel". You can see from the (inaudible) drop down you can click on the option and will immediately be directed into the "properties" tab. From here, you can choose from a suggested filter, a custom filter, you can filter the news based on a monitor ticker list, companies' top (inaudible) key words as well as unfiltered news. 

    For the purpose of this exercise, we're going to filter based on a ticker list because we want this to be linked to our monitor. So you can see through the source option you can link this to your launchpad monitor and then here's where you can select the name of your monitor. We can see from the top of our monitor it is called "monitor 5 3 6"  so as we link this, we can click on the "run" option on the bottom right. 

    So now we have a basic news component that we bring in all the news on our selected monitor. But what if we want to change this for one security? We can edit this monitor by going into "filter", "edit current filter". This will bring you back into the "properties" tab of this specific component. 

    You will see, as well, that we also have an advanced filter on the bottom left. This will bring you back to what looks like the MSC page where you can create a specified, more advanced new search. You can toggle back to the basic filter on the bottom left hand corner as well.

    To make this on a single security component, you can change this back to 'companies' and type in a specified ticker. The auto-complete will help you along the way and you can hit "run" on the bottom right hand corner. So now we have a simple news monitor that will bring in the news on one specific security. You can see this by the hot spot in the top of the monitor and you can see the security that's bringing the news in for. 

    As well, you can change the security by simply typing in to the monitor hot spot and the news will change. A new feature on the news panel as well, are the tabs on the bottom. You will see that we have the News From Microsoft, Top Stories, Most Read, Breaking News and Sports. So we ultimately have five different news panels in one. As we toggle through here, you can see that the topics are changing. You can edit these topics by going into "filter", "edit current filter" and making the adjusted changes. 

    The next topic we're going to cover is charts. (inaudible) side charts are an extension of the chart package in the Bloomberg service. Now, to launch a chart, we are going to go back to the "launch by" toolbar and type in "chart manager". Once it is loaded, we can see our pre-existing charts we created in "G Go", as well the ones we created in launchpad.

    From the manager, we are able to see the chart name, the type of chart and whether or not we are currently using it within the launchpad. We can also provide you with sample charts if you click on the tab in the upper left hand corner. We also have the ability to share charts with fellow colleagues. 

    Now, to get started, we're going to go back to the "my charts" tab and click on the "create new" button. From here, you'll see that you have a choice of eleven different chart types ranging from single security historical to multiple security interday. For the purpose of this exercise, we are going to continue and focus on the single security historical. Once highlighted, you can click on the "create chart" and the chart is created. 

    To customize this chart, please locate the grey tool bar underneath the main border. Here is where you can manipulate the data for the chart. Please note that the chart has a hot spot on the top just like the news panel where you can drag and drop a new security in here or you can simply update it by highlighting it and typing in a new security. 

    We also have the ability to link charts to multiple - to the monitor as well. Underneath the grey toolbar, you will see an option for "charts". From here, you can click on "select list source". You can link the source to the launchpad monitor as well and choose the monitor that we created previously. You will also notice a "show autoplay" option which I'll display for you in a second. 

    Once we update this, you will notice we now have arrows in the upper left hand corner. This is how you can toggle between the securities within the monitor. As well, there is a "Play" button. The "Play" button allows you to automatically have the chart run through the securities on a five second delay. You can edit the second delay underneath the "chart options" as well. If you would like to pause this, you can press the "pause" button.

    Now, going back to the charts, we can go back to "list source" and change this to 'no source' because we're going to keep it on a single security and update this. So now we have our basic launchpad view. 

    Before we wrap up the session, I'd like to show you some tips and tricks that will help you along the way. The first is linking the launchpad components together. Let's say you were interested in looking at a company news as well as just how a security has performed historically. Now, you can change each component manually but let's say you had ten charts and news panels. This can get very time consuming. 

    Bloomberg has thought of this and created a tool to make this much easier. This tool can be found in the "launchpad toolbar", "tools", "group manager."  When it opens, you can highlight the specified components that you'd like to be within the group. So for this example, we will highlight the graph, and the news panel. You will see that they highlight in red as you click on them. Select "save" and then click on the "done" option to complete creating the group. 

    Now, when you update a security in one of the components, you will see that the other one automatically updates. As well, you can drag and drop the security into the components and have them both update.
    
    Now, to take this even further, Bloomberg decided to add a feature for a one-click update option. This can be found within your monitor underneath the "link to" tab, component groups. You will see that we now have the group that we just created through the group manager. As we highlight this and click on "update", we now have the option to search throughout the monitor, left click on a security and have them both update automatically through a one-click system. 

    Prior to linking the monitor to the group, you can left click on a security with no actions. But this is a quick and easy way to make your launch pad view more interactive. 

With Launchpad 2010, we also have a docking feature which is a way to make multiple security components move as (inaudible). You will see, when you line up components there is an amber line highlighting between them. Once you see this, the components have been docked. You will notice a navigation symbol will (inaudible) upper right hand corner of the (inaudible). Now, what this allows you to do is click on the navigation and move the components as one. To un-dock, you can simply click on the border of the component and move it away.  

    Lastly, I want to remind you to save your work. There is nothing more important than saving your launchpad view consistently as you make changes within your launchpad. 

[bookmark: _GoBack]    Thank you for taking the time to learn more about launchpad. As I mentioned before, launchpad is a customizable Windows -esque interface that allows you to quickly, easily access the information you need most. We have covered the basic components of the launchpad application, but if you have further questions or concerns, please contact your account manager or click your "help" key twice.
